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 SDV Pilot 1 Introduction (John Padgett) 10 mins
— Introduction of SDV team and Pilot 2 participants
— Verify readiness
— Key activities and dates
— New wrinkles for Pilot 2
— SDV Pilot 2 schedule “at a glance”
— SDV Pilot 2 expectations

» Collecting Feedback for SDV Pilot 2 (Sarah Wray) 10 mins
— Participant survey
— Ongoing, informal feedback
— Analyzing and summarizing feedback

L
1S arolina aphic |
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 SDV Pilot 2 Overview and Training (Cathy Cole) 60 mins
— Upfront expectations

— Overview of SDV Pilot 2

e Q&A 10 mins

(Note: Team will be on-hand for additional 30 minutes to answer questions, as needed)

‘phiC I
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 Formal Participants: 38

 Informal Participants: 23
— Including Alex Rickard representing RPOs/MPOs

« Total Participants: 61

‘phic I‘ 
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SPATIAL DATA VIEWER

SD

« List of SDV P2 Participants in Appendix of training materials

« SDV Pilot Training and Feedback Team
— John Farley, GIS Unit Manager
— Cindy McCleary, Business analyst and SDV training support
— John Padgett, SDV project manager
— Sarah Wray, SDV business and data analyst
— Cathy Cole, SDV Training specialist, SDV SME

— Elizabeth Roman, SDV tool development, testing, design /
review and QC of Resource Center, SDV help development

— Mike Schoen, SDV help development, testing and QC
Sean Tucker, SDV performance analysis and testing

L J
1S arolina aphic |
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Ve

o Verify status of participants
— SDV Pilot 2 configuration on desktop

v' SDV Pilot 2 configuration installed and loaded
successfully?

v Functioning well?
v' Any outstanding help desk tickets?
v" Any other issues or concerns?

L
1S arolina aphic |
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Key AVg ‘r

« Outline of key activities and dates

Training options 11/30 or 12/1
SDV Pilot 2 officially begins TODAY

Pilot 2 ends December 14th

« SDV Pilot 2 configuration will no longer be available as of
12/22

Pilot 2 summary presentation to SDV Working Group to be
given 1/19/2011

SDV 1.0 “Go Live” scheduled for 2/28/2011

arolina aphic |
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|

» Identifying an SDV Focus Group to provide feedback on
ribbon look and feel

— Will have 7-8 participants review and discuss ribbon design to
gain feedback on user preferences

— Meeting on Tuesday 12/7 from 10:00 a.m. to 11:30 a.m. at NHC
(CR 150)

e For SDV Pilot 2, will conduct an SDV Performance Test on
12/15, the day after P2 ends

— Willinclude 5 experienced SDV users to exercise the system
during a 2-hour window

— Users will be in different locations

o
1S arolina aphic |
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Qsoyv Pil

SPATIAL DATA VIEWER

Rgmts / Define P2 10/1

) & <— P2 Definition Doc - Baseline
9/1-9/30
Design / Dev / Integrate

¥*Agile

10/1-11/05
Test /QA
| )
10/13 -11/12
Promote Data to QC / Verify

11/15-11/19
Final Prep / Loose Ends

P2 S/W Push This Week—, 11/22 -11/29
B Training 11/30 - 12/01

11/30-12/14

12/17
<> <— Participant Feedback Due

].ﬁCDSOT arolina



e Goal is for formal participants to invest 25-30 hours
Into SDV Pilot 2

— Includes training, feedback and related activities

« Communicate with and involve your colleagues in
Pilot 2

— Carry the SDV message

o
1S arolina aphic |
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SPATIAL DATA VIEWER

Where is it?

« SDV Pilot 2 participant survey

In your handouts today
On the SDV portal site document library

tiC

= Document Library

L&

o totalitems 1« items x page [ 25 [s]

., Document Library

Document = Description

& Spv Ppilot2 Survey.doc SDV P2 Survey

Documents for Review
Meetings

Pilot 1

Pilot 2

Requirements
Supporting

arolina,




SDV Pi tiC

« SDV Pilot 2 participant survey
— When is it due?

« Anytime during the pilot after you have finished your
review

» All surveys must be turned in by December 17, 2010
— Where do | send it?

 Email to: SDVPilot@ncdot.gov

 Faxto: 919-707-2210

« MSC# 1521

o Cindy McCleary’s inbox

L
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SDV Pi HOi

Feedback and Questions

bbbbb

* Ways to provide ongoing feedback
— E-Mail address SDVPilot@ncdot.gov —t {
— Resource Center “Contact Us” form e Sm— i

— SDV “walk-arounds”

* Focus Group — Ribbon design
— Specialized group to focus on SDV ribbon configuration

 Kinds of feedback
— Recommended improvements
— Any issues found with the data, tools, and resource center
— System issues
— Things that work well

L
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EEEEEEEE

Analyzing ¢

L
1S arolina aphic |
-/ NCDOT

Feedback Summary
— Collect / consolidate Surveys
— Collect / consolidate feedback emails
— Analyze and report to the pilot team and the SDV working
group
Schedule
— Surveys Due December 17, 2010
— Report to SDV Working group January 19, 2010
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 Upgrades:

— We listened to your comments and suggestions
from Pilot 1

« Materials:

— Training PowerPoint

— Resource material information

— Your time and expertise
 Three goals for SDV Pilot 2 training:
— FACILITATE
— FUNCTIONALITY
— FEEDBACK

].ETCDSOT arolina
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 SDV Pilot 2 Training Outline
— Introduction to SDV
* Display Window
e Contents Window
 Ribbons
« ArcExplorer button
« Map Groups
 Tools
« SDV Resource Center
Scenario

is S

NCDOT
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S

@ Homel Find Display

NC Add Map Md Blsmp
Services Corltent' >.

Review_Pilot2_QC_Add-Ins_And_Ribbon - My Default Map

L line [ZRectangle (&7 Copy to Clipboard

Folder Link | Point
E[na A Arrow ‘= Contents Window
Tools |

NCZoom View
To~

mm‘ /Q\’Tugelgarde | 2+ Measure

» Display . e e
window | o 4 i '_.'nla

Rocky
Mount "

« Contents hoy ? North*’Carolina;’

J‘fg’ v
i d ) Fayetteville 4
Window o : L

11}, New Folder Ny ’3&};‘

71<» Boundaries - Division \ '},\\\\ T
[#<> Boundaries - State ' COLUMBIA 7 '0\‘\‘ .

0 Basemap (NCDOT Community Map) s ou t h 0 \ 'g

Carolina
Mﬂ-
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SPATIAL DATA VIEWER

e SDV Ribbon

@' & )+ NCDOT SDV Pilot 2 - My Default Map - =X
Home Find Display

e a Q}Manage Layers - | &’ Target @ Circle EjMeasure
"'!'D BE ! Q x; Lb == /..ZUne [/ Rectangle " & Copyto Clipboard % —

NCAddMap Add Basemap NCZoom View | Folder Link  Point Analysis Custom Print
Services Content~ - To- ‘ [ Area A nrrow ~ = Contents Window ' print
Map Navigation Create Tools | Print
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SPATIAL DATA VIEWER SDV (4

SDV Pilot 2 Tabs

: | Home | Find  Display

® H ome Tab < ‘;7 HE ‘:> Manage Layers
® %) &g
* Map G I’O U p NCSAdq Map . Atddt Basemap
<*NC Add Map Services e

» Add SDV map services to the Contents Window
— Add Content

» ArcGIS online, layers, Map Content files, KML files,
GIS Services, shapefiles, raster data, Geodatabase,
text files, GPS data, Image overlays

— Basemap
» NCDOT, ESRI's World Topo, Bing, My Basemap

— Manage Layers

» Change layer position, remove, clear cache

[ ]
(@i .
1S arolina
-~/ NCDOT

aphic |



Qspv

SPATIAL DATA VIEWER S . \

NC Add Map Services - 45

[[] AADT Linear Segments

[] AADT Count Stations

[[] Airports

[] Bike Routes

[[] Boundaries - City

[[] Boundaries - County Filled
[[] Boundaries - County Outlined
Os daries - County Shoreli
[[] Boundaries - District

[[] Boundaries - Division

[[] Boundaries - MPO & RPO
[[] Boundaries - State

[[] Boundaries - Urban Areas
[] Bridges

[[] Emergency Operations Centers
[[] Ferry Routes

[] Functional Class

[[] Geodetic control points

I:] HQR - HQW, ORW and SA (High quality water sources)
I:] HQR - NCCrews (Division of Coastal Management)
[:| HQR - NHEO (Matural Heritage Element Occurrences)
|:| HQR - NWI (National Wetland Inventory)

[[] HQR - Water Supply Watersheds

[] HQR - Wetlands (Division of Coastal Management)
[[] Historic Properties

[[] Hospital Locations

[[] Hurricane Evacuation Routes

[[] IRI @International Roughness Index)

[[] NC Place Names

[[] NCMIN Tiers (NC Multi Modal Investment Network)
[[] NHS (National Highway System)
[[] Pavement Condition

[[] Potential Emergency Shelters
[] Rails

[[] Rest Areas

[[] Road Characteristics

[[] STIP - Bridges

[] STIP - Roads

[] Schools

[] State Maintained Roads

[] Streams Lines (Hydro 24K)

[] Streams Polys [Hydro 24K)

[] Truck Routes

[[] USGS DRG 24K Quad Index
[] Unpaved roads

Add Map Service(s) Clear All Select All

Basemaps

< Manage Layers (+) E : kb : & Target (J Circle &> Mea
e / . line [A Rectangle g (&7 cop
15

I
Analys

NCZoom View Folder Link Point
| To~ E/rArea @Arrow | v = Con
| NCDOT Basemaps
/
NCDOT Community Map World Imagery (ESRI)

Grass. ¥ '

Lawn £ A

Park. §
: o ™ N
; S e

VI ETR Ay

i M
Bing Maps Road World Imagery

TR

JET

Boundaries and Places World Physical

OpenStreetMap World Terrain

Clear Basemap

Manage My Basemaps...
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/= SDV Help - Windows Internet Explorer provided by NC Dept. of Transportation
Gg\j - IE, http:figisiq01 . dot.nc.net{SDYResourceCenter fHelp. aspx
I File Edt Wiew Favorites Tools Help Esneor B &
w4 {stueh

vi\éﬂ-x'

f - - reae - 3 Tooks -

SDV Help

<+ SDV Resource
Center
Glossary Help

e Hover over tool

. . )
fo r d eS C rl tl 0 n Adding Excel And Dbase Files Help consists of many topics of interest to SDV users. The currently available help topics are listed to the
Basemaps and My Default Map left. Click on a topic to obtain more information.
Center A Map Display Quickly ‘
Custom Print

e ?Icon on ribbon

Find The Coordinates Of A Point

SPATIAL DATA VIEWER

Home es and Data lelp Support o Contact Us

Help

Measure Tool Highlights = =
° Fl button NC Add Map Services |
NC Find Place b —— .
NC Find Structure | Home I Find Display

NC Identify Route/Milepost

NC Locate Route/Milepost ‘ y EJED < Manage Layers
NC Query Road Characteristics g‘+ ﬁ |

NC View Attributes
NC Zoom To ‘ NCAdd Map| Add | Basemap
Notes j Services Content~| ~

Popup Windows - Using Them Wisely

Query Layers Map

SDV Basemap

Sharing Data Add Content

Views Used As Shortcuts ub e toneenk b poot e,

?lﬂhom You can add content from ArcGIS
Online, a local data source, such as a
file or a geodatabase or you can add .
e 4 content from a GIS service. The content
- you add can be GIS data displayed as a
layer or notes in the map.

@ PressF1 for more help.

arolina phic |
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. Home Tab QN
 Navigation Group MG e

Navigation J

“*NC Zoom To

« State, Division, County, City, Community,
Street

— View
» Create a view of map to return to

« SDV Resource Center
http://gisig01.dot.nc.net/SDVResourceCenter/Glossary.aspx

o
1S arolina aphic |
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) \/

L4 H O m e Tab Llj = / & Target (] Circle
. line [/ Rectangle

* Create Group roder Uk pant
— Folder | T |
— Link
— Point
— Target
— Line
— Circle
— Rectangle
— Area

e SDV Resource Center
http://qisig01.dot.nc.net/SDVResourceCenter/Notes.aspx

iS S

NCDOT

aphic |
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SPATIAL DATA VIEWER

+*
sy Measure

« Home Tab
@Copyto Clipboard |

— Tools Group T Comenes Wikiow
 Analysis | o |
 Measure
» Copy to Clipboard
« Contents Window

e SDV Resource Center
http://gisig01.dot.nc.net/SDVResourceCenter/MeasureToolHighlights

.aASPX
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« Home Tab
— Print Group
«»Custom Print
— Map title, border, North Arrow
e Print
— Map title, printer, size, orientation
Costompunt X

Print [£|

Map Title “"‘ /S o™ )
Title Position Options . - : —
Vertical Horizontal [] Add Map Border | :‘
® Top O Left [] Add North Arrow :
| Custom Print
O Center @ Center N ' Print Map Title
Bottom O right w T ' .
d $ IL Enter the title of your map:
: I |
Page and Printer Settings
‘Page setup | [ preview | [ erint ] < 2

Printer: |\ dot-nhfs01 ITBSR183339 ¥

® Portrait
Size: [l.etter v‘] O landscape
@ Help about printing [ it [ canca |

aphic |
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« Find Tab @
= Home | Find | Display

- Fi n d G r O U p “ = NCFind Place UNC Identify Route/Milepost @ Directions

E NC Find Structure K] NC Locate Route/Milepost

‘ 3 Find 1) Route ‘

Find

 NC Find Place
— County, City, NCDOT Division, NCDOT District
* NC Find Structure
— County, Route, TIP Number, Bridge Number

County

l.é.lamance V] [ W.".Hl ’EMLLNUW v [#)
CIly roufe i1 counly.
| Aberdeen vl —
Format U-2445
NCDOT Division Bridge Number (4 digit
[Division 1 ~ —

NCDOT District

| District 1 v

Uses selected NCDOT Division, too.

Contents l NC Find Place l
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SPATIAL DATA VIEWER

* Find Tab — —
— Find Group continued | ]@EI]“'FRANKFORT
° Flnd ‘ |F'ndapla:e, address, or location {latitude,

“* NC ldentify Route/Milepost

— provides a mechanism to identify a route and its
milepost information at a specified point ==

Select: & Point C Lline
“* NC Locate Route/Milepost [ 5] | e
rom Here: I County/Route | 10 Digit Route |
Stops: |Alamance ;I
* ROUte | Directions x| I = [mormat =]
From Here:

@
X

. - l ‘ Begin Milepost I_
« Directions /"™ | tnaiipost [T

[[] rReturn to start

@

Show distances in:

Show distances in:
Display directions in: English-Us v

Get Route

"
1S arolina phic |
-~/ NCDOT

Route options:

Display directions in:
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SPATIAL DATA VIEWER

« Find Tab EINC Query Road Characteistics
— View Attributes Group
 NC Query Road Characteristics Yiew Atriputes
— Retrieve road characteristics
“*NC View Attributes
— View feature layer attributes

" (2] NC View Attributes

ce L} NCIdentify Route/Milepost #B Directions  |[E8] NC Query Road Characteristics )

ucture NC Locate Route/Milepost [ NC View Attributes
15 Route \
Find | View Attributes
NC Query Road Characteristic NC Query Road Characteristics
Select Point: Retrieve road characteristics by clicking
on the map or entering a countyfroute.
Enter County and Route:

County

NCDOT

iS i i . ‘phicl



Qsov SDV

Home  Find | Display

Orientation Indicator Information Coordinates: NAD_1983_StatePlane_North_ ~

° D|Sp|ay Tab Position: Bottom Left « | V| Position Information | Distance:  Feet, Miles .

. V| Use for Navigation [ Target Indicator V' Grid V' Scalebar

— Options Group Options E Units
 Orients the zoom/pan tool to move around the Display

Window 1) LI

Display Options

Show the application options dialog ko
change display options.

@ PressF1 for more help.

— Units Group
» Select coordinate system, units of measurement
— Select Grid, Scalebar " Rome

Grid

Display lines of latitude and longitude of
the graticule or a reference grid on the
map.

"’ The lines and corresponding labels

A displayed on the map are determined by
“ll the map’s Coordinates setting.

&) Press F1 for more help.

g NCDOT
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SPATIAL DATA VIEWER

« Tools Tab
— Visible when Layers or Notes are selected in Contents Window
— Organize Group

° Remove \:/ Héme Firid Display Tools | App
- - o Draw Order

 Move to Folder = Mkbt SH | Siysangto Front -
- Fg‘;;; i 2 Send to Back ~

O Shal‘e Organize 7

e E-Mall

« Draw Order

— Bring to Front, Send to Back

Manage Layers

Show the Manage Layers Dialog.

@ m———

}
i

The Manaqge Layers dialog allows you to
sort the draw order of the layers in the
,,,,,,,,,,,,,, map and remove a layer's cache.

i
|
.

&) PressF1 for more help.

aphic |
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SPATIAL DATA VIEWER : ;

e Tools Tab 7
— View Group DN

Go Set Default  Show
To View Legend

e« GoTo View
— Zooms to selected content layer

» Set Default View
— Bookmarks the map

» Show Legend
— Shows features of selected content layer

Show Legend

= Show or activate the legend window
and display the legend for the selected
layer.

@) Press F1 for more help.

®
1S arolina aphic |
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SPATIAL DATA VIEWER S

e Tools Tab

- EffeCtS G r O U p Transparency Transparency Enhance Swipe
Change the transparency of the . }
® T I’an S pare n Cy selected item(s) to allow you to see Effects

more or less of the underlying data.

- FOI‘ Se I eCted Iaye r Move the slider bar to adjust the

transparency; the higher the
percentage, the more transparent the

item,
° Enhance @ PressF1 for more help.
— For image ——
Change brightness, contrast and
Gamma correction of imagery data.
o Swipe

— For selected layer  swee

Use your mouse to pull back the
selected item(s) on the map to reveal
what's underneath.

].I.VCDSOT arolina
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SPATIAL DATA VIEWER

« ToolsTab
— Query Group
» To query a selected layer from the Contents Window
» Access SDV Resource Center for Help

(= SDV Help-Query Layers - Windows Internet Explorer provided by NC Dept. of Transpartation

":",‘x [cooge |2

& - 9 - (irogo - (G Took -

Query SPATIAL DATA VIEWER

Query

- Help
I Query Layers
Add Map Elements To A Map
‘Adding Excel And Dbase Files

The Query Tool's purpose is to create a query layer from a selected layer in the Contents Window. The source
layer remains unchanged following the selection. Once created, the query layer is added to the Contents Window

Basemaps and My Default Map and can be manipulated like any other layer. A query layer is based on criteria specified in the tool's dialog box
Center A Map Display Quickly using standard SQL syntax. The syntax can be created using the dialog's buttons and selected fields or by keying
Custom Print the syntax directly into the Query Preview Box.

E-mailing Data Begin by selecting a layer within the Contents Window, then clicking on the Tools tab of the Ribbon. The Query
Find The Coordinates Of A Point

Maasure Toal Highlights
NC Add Map Senices
NC Find Place Tool, @4¢%.| can be found on the right within the tab. Clicking this toal wil bring up the Query Dialog Box
NC Find Structure

NC Identify Route/Milepost

Query

NC Locate Route/Milepost
NC Query Road Characteristics oo itS = overen o =
% the NHS map service e T v - we ] [ v
NC View Attributes e -
NG Zoom To is the selected layerin _— ;:;;;{v_-;a——- e
the Contents Window, Ty - | on
Hotes its R H—
Popup Windows - Using Them Wisely Sfioid names ot
Query Layers a@nomarically crpecr
SDV Basemap tnthe Fields box o 13 |
Sharing Data )
Views Used As Shortcus
i ) e ]
e Lo ] o
Done: & Local intranet:

arolina aphic |
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« Appearance Tab

a— ﬂ/ Minimum: | <
Maximum: | <
Popup | Transparency
Content v

— Po p u p G ro u p Popup | Transparency
. . . Popup Content
¢ P rovi d €S 1IN fo rm atl on Sppecl:l’y what information you want to
. di_splay in the item's associated popup
about item selected T L
— Transparency Group F’”"’”““ o

LE}/ Minimum: <None>
Maximum: | <None>

Transparency

Change the transparency of the
selected item(s) to allow you to see
more or less of the underlying data.

W Maove the slider bar to adjust the
transparency; the higher the

— D i S p I ay Ra 1] g e G rou p | percentage, the more transparent the

I item.
& o F Service Layer NCDOT ¢ -
—_— : | @ Press F1 for more help.

Home Find Display Tools Appearance

o= ﬂ/ Minimum: | <None> ~ | &= Use Current

Maximum: <None> - EQUSQ Current = Use Current
Popup || Transparency :

8 Clear Use the current map display to set the
Content & maximum zoom level,

Popup | Transparency Display Range

®
1S arolina aphic |
-/ NCDOT |
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* ArcGIS Explorer Button

New '9” ;

Open | .

Save .

Save As :e

ArcExplorer Map, My Default Map, New Basemap *

Share ' Save As ‘ 8
Upload ArcGIS Online, E-mail map, E-mail view share L
Print Print

Map Properties

ArcGIS Online

Sign in

&t R E

Set Application Configuration

phiC I
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SPATIAL DATA VIEWER

FACILITATE

e Measure
e Access NC and NCDOT data
e Share information

FUNCTIONALITY

« More NC map services
e More NC tools
e SDV Resource Center

FEEDBACK

 Your feedback is critical

iS b

NCDOT
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Qsbyv SDV F ra

Collapsed Bridge Scenario

November 30, December 1, 2010
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gis

NCDOT

 Collapsed Bridge Scenario

Change coordinate system to NC State Plane Feet

Add Map Services

SDV Resource Center

NC Find Tools

Query Tools

Zoom to incident area (mouse, NC Zoom, navigation tool)
Change Basemaps

Find road, bridge characteristics of incident

View attributes of collapsed section

Create note for area in question

Email the map

Add external data to the map

Measure area around collapsed bridge, distance to alternate route
Add North Arrow, Print Map

arolina aphic |
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e QOpen SDV

e Add NC Map
Service

o Select layer

Contents
Window

_ rolina

@\ ’J s Service Layer NCDOT SDV Pilot 2 - My Default Map = X
| Home Find Display i Tools Appearance @
SIM I 2 Target (] Cird oM i ;
@ +’3 E}E 1 Manage Layers o SO Lb / 4 Target (J Circle | +* Measure é
Zline [ Rectangle @ Copy to Clipboard
NCAdd Map Add Basemap NC Zoom View 1 Folder Link  Point | Jetre= Custom Print
Services Content~ - ‘ To~ ‘ [Z Area @ Arrow | +~ = Contents Window | print
|| Navigation | Create | Tools | print
/ Bontstown 3 i
wn
Kenmcky ik "'5’ ﬁ_ SPATIAL DATA VIEWER
e L e -
» Same| B -
ar, SO A - Display

P i A
¥ ' -7 » ’ - '-‘ -~ h s
£L ”y — Damullle.
- ¥
Ay e
29 ol 0 o p
isee T b = 7 &
2 A - —
el Ly (_J' 7 A
/f‘ . Va
b i e
3 f = :
) LT A ; &7 = )
¥ 8 ATy Lo ’*}“r'—m = ty
Contents sl D\ T -
onte -
} 714> Boundaries - Division South N
| @< Boundaries - state ‘i l’q'é rolina
[7)<» Boundaries - County Outlined "4% %
| Basemap (NCDOT Community Map) COLUMBIA = "
_._, Sumter
Abken Orangebirg Sanle :‘E}
- &~
‘\a < .
&, i
) e
| 34 = W
- - e 7.:
7 % arfeston
by
ta .. \,'
. o % R,
Ha Hoyal
Posttion m&s 496989.09 0

phic |

Window
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To change the map coordinate system:

4 Home Find Display I Tools Appearance -
Orientation Indicator Information Coordinates: NAD_1983_StatePlane_North_ ~

Position::Bottom Left ~ W Position Information || Distance: Feet, Miles v
V| Use for Navigation | Target Indicator i V| Grid V| Scalebar
Options M | Units )
Choose Coordinate System
1. CIICk DISpIay tab Choose a coordinate system
2. Click the coordinates dropdown [searan |

=] Lb Pro Jected
ARCEqualarcSecond

3. Click <More>
4. Choose the correct coordinate system

Continental
CountySystems
GaussKruger
NationalGrids

“d
Iz

StatePlane
StateSystems

=

EE]E]EJE]E]ﬂ@EIE]E]

WorldSphereBased

aphic |
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Find Davidson County

1. Click Find tab

2. Click NC Find Place

3. From the County drop
down list choose
Davidson County

4. Click the search button

Home

5% NCFind Place  {J NCIdentify Route/Milepost € Directions
T} NC Find Structure [ NC Locate Route/Milepost

3% Find ﬁ Route

Find

County
l Davidson

City

[Aberdeen v

&

NCDOT Division
[ Division 1 v|

NCDOT District

| District 1 v/

Uses selected NCDOT Division, too.

E3

Edgecombe

Forsyth
Franklin

Gaston
Gates
Graham —
Granville

Greene

[
(&)

£

NCDOT
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 County is located,
now zoom in

T mume | roa | ouse
TEMCrngfuce  {NCicentty Routertiepont @ Onections  EBINC Query Road Craactentics
T MC Fins Structure. (3 NC Locate RouteAtiepont ZINC View detrites

X rea 7 Route
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SPATIAL DATA VIEWER

o:.
; I Home l Find

Service Layer

Tools

Display Appearance

NCDOT SDV Pilot 2 - My Default Map

b D [E] <> manage Layers
+ B

'NC Add Map

Add Basemap NCZoom View
Services Content~ % To~
Map J; Navigation

&N

o Measure
@ Copy to Clipboard
| = Contents Window | |

Folder Link Point

& Target (F Circle °

..Z Line [z Rectangle
Analysis

M Area @ Arrow | v
f

Create

Tools

|

1. Click Home tab

2. Click Contents Window (there are
2 ways to get there)

3. Check the Find County: Davidson
option box

Right click on Find County:
Davidson

5. Click “Go to”

6. Or Double Click Find County:
Davidson

SDV zooms in to county

g1s

NCDOT

@ Boundaries - Division
@ Boundaries - State

(%[ Find County: Davidson
() Basemap (NCDOT Community Map)

GoTo
Show Popup
Fiy Along...

Shate...
Remove

NCDOT Find Place  Contents |

FTeeUE

Rename
Jr  Move to Folder...
Symbol
Label
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Qspv SDV

[[] AADT Linear Segments
[] AADT Count Stations
[] Airports

[[] Bike Routes

[] Boundaries - City

[] Boundaries - County Filled

[] Boundaries - County Outlined

[[] Boundaries - County Shoreline

[[] Boundaries - District

[T] Boundaries - Division

[[] Boundaries - MPO & RPO

[[] Boundaries - State

[[] Boundaries - Urban Areas

G
[] Emergency Operations Centers

[] Ferry Routes

[[] Functional Class

[[] Geodetic control points

[[] HQR - HQW, ORW and SA (High quality water sources)
["] HQR - NCCrews (Division of Coastal Management) F
[:I HQR - NHEO (Natural Heritage Element Occurrences)

D HQR — NWI (National Wetland Inventory)

[] HQR - Water Supply Watersheds

[] HQR — Wetlands (Division of Coastal Management)

[] Historic Properties

[[] Hospital Locations

[[] Hurricane Evacuation Routes

[] IRI (International Roughness Index)

[[] NC Place Names

|:| NCMIN Tiers (NC Multi Modal Investment Network)

[:| NHS (National Highway System)

[[] Pavement Condition

[C] Potential Emergency Shelters

[ Rails

[[] Rest Areas

[[] Road Characteristics

[] STIP- Bridges -
[[] STIP - Roads

[] Sehools

State Maintained Roads
[T] Streams Lines (Hydro 24k)

Add Map Serviceis) Il Clear All || Select All I

B, > §8 e
5

NCAddMap Add Basemap
Services Content~ v

Map

NC Add Map Services

1.NC Add Map Services

Add SDY map services to the Contents
Window

2.Click box for layers of
Interest

3.Click Add Map
Service(s) button

4.Click the map service
checkbox in the Contents
Window

(con’t on next slide)

<

NCDOT
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@ &) Senvice Layer NCDOT SOV Pilot 2 - My Default Map - = x
7| Home | Find Display Tools  Appearance (7]
@ '3 2 <> Manage Layers (oz x Lb - / 4 Target (J Cirde ° &* Measure v,
EHE ‘ N\ £ line [ARecangle @Copyto Clipboard E —

| Analysi Custom Print

NCAddMap Add Basemap ' NCZoom View  Folder Link Paint
Services  Content~ v ‘

alysis
| To- [ area  Aamrow ~ = Contents Window | Print
Map || Navigation || Create I Tools | Print

] ,,-' gu Ry ol Ya fn cdum k\fi = u o
- | SPATIAL DATA VIEW

68
]

VIEC,

Iredell
Dayiy

Davidson
Coumy

oignty

afngd

Contents

@ Boundaries - Division

@ Boundaries - State

[#<> Boundaries - County Outlined
B Find County: Davidson

[]<> Bridges

@ State Maintained Roads

G Basemap (NCDOT Community Map)

’7

MEGS

NCDOT

41 | contents | NC Find Place

ity
ol 1893780.38 23089203 R

arolina
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1. Click Find Tab
2. NC Find Structure

Note NCDOT SOV Mot 2 - MWy Defaul Map
e —

fing | Ouplay  Teoh  Appearance “
Fnd Pace Oncummm.m ﬁmmmm

8 1 Locate I NC View Astritrates
(] 7 Reute
3. Enter County - R

4. Enter Bridge Number

5. Click Find symbol . ]
6. Point is symbolized on 1 —
map ey < 4

7. Double Click to zoom
to result

| (eShl)

Suarsm WO

].iTCDSOT arolina
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Ospv SDV P

View Road Attributes

1. Click NC Query Road
Characteristics

2. Select Point
Enter Davidson

4. Click on Road where
bridge collapsed

5. When feature is
selected, right click
feature, View Attributes

=

Home | Find | Display Tools Appedy

NCDOT SDV Pilot 2 - My Default Map

a4 % NCFind Place 0 NC Identify Route/Milepost @ Déen]/nm - NC Query Road Characteristics

T NC Find Structure K] NC Locate Route/Milepost | E; NC View Attributes
% Find 1) Route
Find View Attributes

‘# Select Point ealures
: “ { Go To First Feature \
= Go To Point
e él [ ViewAtibues
— Add To Contents Window
Remove

.:_" _ ,—J

[ [ M Note

NC Query Road

Select Paint (@)

Enter County and Route:
County
Dawdwn v

ST AT

Contents

@ Boundaries - State y
[#<> Boundaries - County Outlined

[7<> Bridges

[714» Boundaries - Division
[2)< state Maintained Roads
[# i Find Bridge: 0249 in Davidson 4 P

(D Basemap (NCDOT Community Map)

| Contents | MCFind Place

EJ NCDOT Query Road Characteristics View Attributes

Select Point 1: 1 features

{r—
View Altrbutes | Select Attributes |

[v] Feature [] One Way Direction Flag
[] Gl FiSegld [] Route 2 Class

(] Fiom Event Pescent ] Route 2 Number

[] ToEvent Percent [[] Route 2 Primary

[] Route 1 Class [] Route 2 Direction

[[] Route 1 Number [[] Route 2 Stant

|C] Route 1 Primary [ Route 3 Class

[] Route 1 Direction [] Route 3 Number

|0 Route 1 Stant ] Route 3 Primaty

|[] Route Status [[] Route 3 Direction
[] Source Document Type ] Route 3 Start
[] Sowce Document Number  [_] Route 4 Class
[] Revision Document Type (] Route 4 Number
[] Revision Document Number [_] Route 4 Primary
("] Route Subcategory [[] Route 4 Direction

["] Route 4 Staet
[] Route 5 Class
[] Route 5 Number
[] Route 5 Primaty
[] Route 5 Direction
[] Route 5 Stast
[] Route 6 Class
[] Route 6 Number
[] Route 6 Primary
("] Route 6 Direction
[] Route 6 Stast
[] Street Name:

(] Route Ramp Code

BEETITHY

b

000000000000
g mo :ﬂ
c

.
e8¢

oo
. §2
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Ospv S

To Query
1. Click Tools Tab

2. Click layer from
Contents Window

3. Click Query

4. Click field, operator,
and value

5. Click Test
6. Click OK

7. Notice symbology
change

~ Home g

~ \ 7 Oepe Order {

Ye- (I 1 [ @ »
= ‘L’ el T tong 1o Fremt &)
Remove Moveto  Share [-Mae

Poider Yienatobac * I Vieew

g Bradge 0243 m Damdron
Semap PNDOT Community Magy

<
Corterts | NG Pird Mace

—

>pav05 o"n‘ux
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Zoom Tools

1. NC Zoom To Street
2. Mouse -Scroll

3. Go To option

4. Orientation Indicator

Division

A County

City

: Community

Street

' GoTo

: Show Legend
FE 249

B Note Share...

Remove
[#<> Boundaries Rename
[#)<> Bridges « | Move to Folder...
[1<» Boundaries Pl

[ Find Bridge: 0249 in Davidson
O Basemap (World Imagery)
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Ospv SDV

SPATIAL DATA VIEWER

E] | Service Layer NCDOT SDV Pilot 2 - My Default Map - =X

J--‘
=

‘ Home [ Find Display Tools Appearance

c] “'-!-j @m < Manage Layers Q X} J‘J ) / j‘::::et (4 circe e > Measure g) ::}‘j
Ana C

s Z Rectangle l@ Copy to Clipboard
NCAdd \Nap Add |Basemap NCZoom View Folder Link Point u
ot - o [ Area A Amrow ~ = Contents Window || print

NCDOT Basemaps S

Change Basemap
1. Click Home tab

2. Click Basemap
button

3. Click ESRI World

NCDOT Community Map World Imagery (ESRI)

Contents

I m 1< Bour
ag e ry @ Bout World Topography Boundaries and Places ‘World Physical
— A — r
[#<>» Bour ;‘u ¥ = 7/ 4
@ B Find € #omon 2 s i3 A L
Fensr -~ e
T @ 7 & P S
O Brids o o @ S par i
@< state S e e
@ i 3 & My < ¥
OpenStreetMap World Terrain

Clear Basemap

Manage My Basemaps...

=
/ e

esrije

s s
Position 1586604.78 720765.53 ft % » ‘Source: USGS

o(s
\Cnntents\ NC Find Place ‘ 18aft
— -]

arolina



Osbv SDV Pilot 2 Training

@ B+ Service Layer NCDOT SDV Pilot 2 - My Default Map
o/ )
(7

Home Find Display Tools Appearance
r ] 2 e e -
[E o FIE] <> Manage Layers 3 \) | = .-/ 4 Target (/] Circle % % Measure Al R
g BE — - « line [/ Rectangle i Copy to Clipboard =
NC Add Map Add Basemap NCZoom View Folder Link Point . Analysis Custom Print
Services Content ~ - To~ _.ff Area ¢ Amow - = Contents Window Print

Map Navigation Create Tools Print

DV

GPATIAL DATA VIEWER

Contents
=] 249
B MNote

714> Boundaries - State

714> Boundaries - County Outlined
71<> Bridges
» Boundaries - Division
7]€» State Maintained Roads
¢ Find Bridge: 0249 in Davidson
(; Basemap (World Imagery)

Contents | NC Find Place A
esri®

Source: USGS

A/ : ’ }g'l North Carolina Department of Transportation Geographic Information Systems (GIS)
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SDV

Measure Collapsed
Bridge

1.
2.

3.

Service Layer

e
(4]

NC Add Map
Services  Co

[ < Manage Layers

+) BB

Add  Basemap
ntent - -

Map

Click Home tab
Click Measure tool

Click the first button /oy,
for length and the
middle button to
measure area and
select unit of
measurement

Click, draw line, then
double click to finish

Measured area gets
hi-lighted

Measure X

BE® [« = ’

Length: 289.199 Feet

I Clear [
e

7

Contents
BE] 249
[/ Note
@'Q Boundaries - State
[#)€» Boundaries - County Outlined
[7 <> Bridges
[‘J-ﬂ') Boundaries - Division
[#)<> State Maintained Roads

[71%@ Find Bridge: 0249 in Davidson
@ Basemap (World Imagery)

Contents | NC Find Place

NCDOT

Find Display Tools eal

Folder Link Point

lllll

NCZoom View
To~

Navigation

)

A\
!

Sl

¥

NCDOT SDV Pilot 2 - My Default Map

/ & Target (F Cirdle

« Line [ARectangle

4 area Aamow

Create

ik,
lﬁ Copy to Clipboard e
(] Print
- = Contents Window

Tools
'8 .
T
~ .

. - s
adl '
v

>

¥

\ 'l, -

SR:+2294

=~

a £

/o

™,
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Create a Note ® .
1. =
2.

. Add information to |

Click Home tab

Click Area notes =S
button

Click on the map to
outline the area of
concern

Finish the area by
double clicking

the note window : :-;::,,.:_::._. |

North Carolina Department of Transportation

SDV Pilot 2 Training

Geographic Information Systems (GIS)
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S |

Sending E-Mail Options

1. Click E-Mail icon on note
2. ArcGIS Explorer button
3. Click Share

— E-mail Map sends a map
package, others will
need the same access to
the data

— E-mail View sends a jpg

— You can also right click
the mouse and select
Share option

i B cCollapsed Bridge + X

TR

ArcGIS Explorer Note - Message (Plain Text) = =R
Message | Insert  Options  FormatText  Review o @
- s 1 - Follow Up ~ )
¥ R B =k
Er) , High Importance
Paste B 7 U | ¥- A = = Z= | 4 i=  Address Check Attach Attach Signature Zoom
- - Book Names  File Item~ - § LowiImportance
Clipbo... & Basic Text . Names Include Tags | Zoom
To [neoori
=1 = I
Send

|
|
Subject: IArcGlS Explorer Note }
|

Attached: | @] Note.nme (2 KB}

Message from sender:

The attachment to this e-mail can be viewed with the Spatial Data Viewer (SDV). You can find information about SDV at
the SDV Resource Center:

http://gisiq01.dot.nc.net/SDVResourceCenter




SPATIAL DATA VIEWER

‘ Home l Find Display

<> Manage Layers | @ &

d Map |Basemap ‘ NCZoom Vie
ices Content~ > To~

85 ArcGIS Online Navigation
ArcGIS Layers...

Add Content — External Data
1. Click Home tab

2. Click Add Content i
dropdown

3. Select File type and path

Map Content Files...
KML Files | »

6 O

x
x
F

GIS Services...

Shapefiles...

Raster Data...

Geodatabase Data...

Text Files...
GPS Data Files...

ey R~ VI G-

Image Overlays...

Image Overlays...

Add an image overlay from a png, bmp,
jpeq, gif or tiff file ko your map.
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£ S Image Overla NCDOT SDV Pilot 2 - My Default Map
\ 9 y

Home | Find Display Tools

[EE <> Manage Layers e | / 4 Target (/] Circle o2 Measure
~ '8 ) « Fo
@ +J B .‘ \) kL 2 line [/ Rectangle [ Copy to Clipboard

NCAddMap Add Basemap NCZoom View Folder Link Point Analysis
Seivices | Contnty > To 4 area  Aamow ~ = Contents Window
Navigation Create Tools

Map

[#]€> Boundaries - State

~

[¥]» Boundaries - County Outlined

F <» state Maintained Roads
[7]F Find Bridge: 0249 in Davidson
@ Basemap (World Imagery)

335ft

esrie

Source: USGS




SPATIAL DATA VIEWER

Custom Print

Map Title
|Collasped Bridge* 249

=

 |Custom

Print

Print Title Position Options
- ] i - Vertical Horizontal Add Map Border
Print the Map using Custom Print Frint [ @m  Ouwr | O awanomnamon
O Center ® Center

Click the Home tab
Click Custom Print
Enter Map title
Select page options
Select North Arrow
Choose page settings ' E——

Click print preview or print LAy LY

1
O Bottom O Right = :.L-L
Z

LPage Setup ]

No oo s bdhE

].ﬁCDSOT arolina
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SPATIAL DATA VIEWER - I \/ r

Find | Display

Additional Tools that have been added:
tu NC Identify Route/Milepost | €@k Dire
Ire NC Locate Route/Milepost :

NC Identify Route/Milepost —

NC Identify Route/Milepost
Click on a route to identify the route

and milepost at that location.

NC Locate Route/Milepost |

;ﬁj Route

Find

NC Locate Route/Milepost

NC Locate Route/Milepost
Locate a route and milepost on the map.

LQ NC View Attributes |

View Attributes

NC View Attributes NC View Attributes

View feature layer attributes

NCDOT

iS Sl
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